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Siebel Basics

Overview
Overview 0

This booklet tells you some of the most important things you need to know to use 
Siebel eBusiness Applications. It’s organized around the major parts of the 
application’s interface—including such Windows-generic items as the menus and 
the toolbar, as well as such Siebel-specific elements as the tab bar and the view bar. 
While looking at each of these interface elements, you’ll come to understand several 
major Siebel concepts and will learn how to navigate the application to get your job 
done.

You’ll find this booklet useful to read before you get your Siebel application and 
upon first opening and using the application. You can use the following page as a 
quick and easy introduction to the key navigation concepts in the rest of the 
booklet.
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Siebel Basics

Menu Bar
Menu Bar 0

Like most Windows applications, the Siebel user interface shows a menu bar at the 
top. You use this menu bar to choose any of the application’s commands, as shown 
in Figure 1. 

Figure 1. Using the Menu Bar

To see the list of commands under a menu, click
the menu name. For example, the Reports menu

shows which reports you can run.

The list of commands that
appears depends on where
you are in the application; in
another context, you would
see a different list of reports.
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Menu Bar
Using Submenus 0

In addition to commands, some menus contain submenus, as shown in Figure 2.

Figure 2. Submenus

Drag over a menu item to see
the submenu of commands.

Choose a command from a
submenu just as you would
from a regular menu.
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Menu Bar
Other Ways to Perform Actions 0

Many of the commands in the menu bar are also available in other parts of the 
application. The two most common alternatives are:

� Right-clicking, which brings up a shortcut menu of commands.

As with other Windows applications, the menu that appears depends on where 
you right-click. For example, right-clicking inside a form applet brings up the 
commands New Record, Copy Record, and Delete Record. On the other hand, 
right-clicking inside a field on a form applet also brings up Copy, Paste, and 
Select All because these commands make sense in that context.

� Using shortcut bars.

These include the toolbar (described on page 6), the tab bar (on page 13), and 
the view bar (on page 16).

Figure 3. Right-Clicking

When you right-click
inside a form applet, a

shortcut menu appears.
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Toolbar
Toolbar 0

As with other Windows applications, the toolbar gives you quick access to the most 
commonly used commands: clicking a button on the toolbar is equivalent to 
choosing a command from a menu in the menu bar.

Working with Records 0

A group of related pieces of information is called a record. For example, all the 
information about a contact—including the contact’s name, address, and phone 
number—make up a Contact record.

When you use Siebel applications to add new information or retrieve existing 
information, you’re working with records.

Figure 4. Taking Shortcuts on the Toolbar

Clicking a toolbar button, such as
Copy, is a shortcut to choosing that

command from the menu bar.

If your cursor stays over a button long
enough without clicking, the name of
the button appears.

Figure 5. Adding, Copying, or Deleting a Record

Click here to make an exact
copy of the active record.

Don’t worry about this button
(Insert Record) for now.

Click here to add a
new record.

Click here to delete
the current record.
6 Siebel Basics Version 6.0
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Toolbar
After you add a record, or copy an existing one, you can enter information in the 
record’s fields, as shown in Figure 6.

Figure 6. Modifying a Record

To modify a record, click a
field and start typing.

To move to the next field, press TAB
or click inside the new field.
Version 6.0 Siebel Basics 7



Siebel Basics

Toolbar
Moving from Record to Record 0

When you’re looking at a list of records, the row pointer (>) shows which record 
is active—the one you intend to act on. For example, when you choose the Copy 
Record command, it’s the active record that will be copied. 

To move to another record, simply click the desired record. (But don’t click the 
hyperlink or you’ll go to another view.)

If you want to move to the next record in the list, you can also use the Next Record 
button  on the toolbar or use the DOWN ARROW key on your keyboard.

Figure 7. Active Record

The > and the
highlighting show which
record is active.
8 Siebel Basics Version 6.0
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Toolbar
Searching for Information Using the Find Command 0

Moving from record to record is easy; however, if you have hundreds of records, 
looking at every single one can be a time-consuming way to find exactly what 
you’re looking for. Doing that would be a little like going through a phone book page 
by page to find the phone number of a person whose name you know.

A faster way to find information is through the Find command, as shown in 
Figure 8.

NOTE: Your Find dialog box may have different items in the two columns, depending 
on which application you’re using.

Using the Find command is fast because you can find records from anywhere in the 
application. For example, with Find you don’t have to be looking at Contacts records 
to find information about a contact. Also, the Find dialog box displays only the most 
frequently used records and fields, so entering your search criteria is easy, as well.

If you want to query by records and fields that don’t appear in the Find dialog box, 
use queries, described in the next section.

Figure 8. Finding Records Through the Find Command

Click the type of record you
want to find.

Click the binoculars on
the toolbar to bring up
the Find dialog box.

Type your search
criteria and click Find.
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Toolbar
Searching for Information Using Query by Example 0

Another way to find information is through queries, or query by example. In a query 
by example (sometimes called QBE), you provide what you already know to find 
out what you don’t. Performing a query by example is a two-step process:

1 Entering the query—starting the query and specifying your search criteria

2 Executing the query—telling the application to find all records that match your 
search criteria

After you enter your search criteria, remember to click the Execute Query button 
(shown in Figure 9) to see the query results. You can also execute your query by 
simply pressing ENTER.

Once you’ve run a query, you can save it if you expect to use the same search 
criteria later. The following section tells you more about reusing queries.

Figure 9. New Query and Execute Query Buttons

On the toolbar, click the left
magnifying glass to start a new query.

After you enter your search criteria, click the
right magnifying glass to execute the query.

Figure 10. Entering Search Criteria

Type the text you’re
searching for into one

or more fields.

Use an asterisk (*) as
a wildcard if you know
only part of the text.

This query by example looks for all
accounts that both start with P and

whose site is Los Angeles.
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Toolbar
Using Predefined Queries 0

Your application may come with a set of predefined queries. These are queries for 
which someone has already entered search criteria to save you time. For example, 
suppose that the person who configured your application knew that you would 
frequently need to find all accounts located in California. Rather than having you 
enter and execute this query each time, the configurator might have created a 
predefined query called “CA Accounts” with these search criteria. Now, when you 
want to execute the query, all you have to do is choose CA Accounts from the list 
of predefined queries. You do not need to specify the query criteria because these 
have already been specified once (and saved).

You can also save your own queries so that they appear in this menu. After 
executing your query, just choose Query � Save Query As, and then give your 
query a name.

Predefining commonly used queries is just one way in which your application can 
be configured for your needs. You or the person who configures the applications for 
your entire organization can make many changes to your Siebel application—such 
as setting which buttons appear in the toolbar and which view appears when you 
first log on—that may make your particular application look somewhat different 
from the one shown in this booklet.

Figure 11. Predefined Queries

Then click one of the items in
the list to execute the
predefined query.

First, click this triangle to see
the list of predefined queries.
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Toolbar
Sorting Results 0

After you’ve run a query, you can sort its results so they appear in order with respect 
to any of the fields. For example, you can sort alphabetically on a particular text 
field or in chronological order on a particular date field. You can also see the items 
sorted in either ascending or descending order.

You can sort items any time, not only after performing a query. For instructions on 
sorting, see “Changing the Sort Order” on page 21.

Saving Your Changes 0

You may wonder whether the toolbar has a Save button. In fact, there is no Save 
command anywhere in Siebel applications because each application saves your 
changes as you go along. Each time you leave a record (by clicking anywhere 
outside of it), your work is saved.

Correcting Mistakes 0

If you make a mistake as you work with records or queries, you can click the Undo 
Change button.

The Undo button is particularly useful if you accidentally press a key and don’t 
know what you did.

If you want to undo all your changes to a record (rather than just the most recent), 
choose the Undo Record command from the Edit menu. This command undoes any 
changes you made since the last save—that is, since you last left a record.

Figure 12. Undo Button and Redo Button

Clicking the Undo Change button
reverses your most recent action.

To redo the change, click
the Redo Change button.
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Tab Bar
Tab Bar 0

A Siebel application consists of screens, views, and applets—shown on page 2 and 
explained later in this section. The tab bar, shown in Figure 13, contains the names 
of the most commonly used screens.

Figure 13. Tab Bar

The highlighting
shows which screen
is currently active.

Click another name to
make that screen

active instead.
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Tab Bar
Screens and Views 0

The terms screen and view have somewhat special meanings in Siebel applications. 
These terms refer to specific parts or aspects of an application, and understanding 
them is important for finding your way around an application. 

As you can see from the tab bar, Contacts is just one of several screens available in 
this application. Other screens in this sales application include information about 
Accounts, Price Lists, Products, and other sales-related items. The list of views will 
depend on which screen you’re on.

Figure 14. Screens and Views

All the listed
views are

different ways
of looking at

your
contacts.

This circled region is the
Contact State Analysis view,

one of the views available
from the Contacts screen.

The tab bar shows the
names of the most

commonly used screens.

The Contacts screen
contains all the available

information about contacts.
14 Siebel Basics Version 6.0



Siebel Basics

Tab Bar
Applets 0

A view consists of one or more applets. An applet is an area of an application’s 
interface that displays records. A list of records is an applet. A single record that 
looks like a form is also an applet.

For example, the Contact Opportunities view shown in Figure 15 contains two 
applets: the Contact form applet and the Opportunities list applet. The Contact 
applet displays one contact record at a time, while the Opportunities applet lists all 
the records that represent opportunities associated with the contact. 

Figure 15. Applets

This form applet
shows a single
contact record.

This list applet
shows several
records—all
opportunities
associated with
the displayed
contact.
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View Bar
View Bar 0

Now that you understand screens, views, and applets, and know how to use the tab 
bar to move from one screen to another, take a look at how to move from view to 
view and applet to applet.

Switching Between Views 0

Since only one view appears on-screen at any one time, the Siebel interface gives 
you a fast way to switch from one view to another—the view bar.

NOTE: Different users have access to different views, depending on their responsibility in 
the organization. For example, salespeople and call center representatives have access to 
different views than do system administrators or executives in the same organization.

Figure 16. View Bar with Tab Bar

This is part of the
view bar for the

Accounts screen.

The highlighted
item is the active
view.

Click another name to
switch to a different view
on the same screen.

The name of the active screen appears
as the highlighted tab in the tab bar.
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View Bar
The list of views on the view bar is exactly the same as the list of views under each 
submenu in the Screens menu. However, clicking a view on the view bar keeps you 
in the same context (for example, the third record in a list of the four accounts 
starting with L), whereas using the Screens menu starts you over (with the first 
record in the complete list).

Types of Views 0

While there are dozens of different views available in a Siebel application, most of 
them are one of two basic types: a list-form type or a master-detail type.

List-Form View Type
One of the two most common types of view is a list-form view (sometimes called 
simply a list view). A list-form view shows a list applet at the top of the screen and 
a form applet below.

An example of this type of view is My Accounts.

Figure 17. List-Form View Type

This form applet shows
most of the fields from the

active record—in this
case, the active account.

This list applet shows
multiple rows of records,

one row per account.
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View Bar
Master-Detail View Type
Another common type of view shows a form applet at the top and a related list 
applet below. The two are related in that the records of the list applet are “children” 
of the “parent” record in the form.

An example of this parent-child, or master-detail, relationship is the Account 
Contacts view (the Contacts view in the Accounts screen).

Only contacts associated with the account are listed in this view. The underlying 
database can contain many more contacts, such as those associated with other 
accounts. But you would not be able to see them all at once unless you looked in 
another view, such as My Contacts (which shows the contacts for all your 
accounts).

Figure 18. Master-Detail View Type

The form applet gives
information about a

single account (in this
case a company).

The list applet shows all the
contacts associated with
that account, such as all

the company’s employees
who are prospects.

Any new record you add to this list
applet will automatically be

associated with the above account.
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View Bar
Switching Between Applets in a View 0

When you’re looking at a particular view, you sometimes want to switch from one 
applet in the view to another. For example, when you want to create a new record 
in the bottom applet, it’s important that the bottom applet be active before you 
create the new record. (Otherwise, if the top applet is active, the record will be 
created in the top applet.)

Pressing CTRL+TAB also switches to another applet.

NOTE: Don’t worry if you mistakenly add a new record to the wrong applet. Just 
choose Undo Record from the Edit menu to start over.

Figure 19. Switching Between Applets

The dark-blue tab
and outline show that

this applet is active.

To add a new Contact
record, first make the

Contacts applet active
by clicking anywhere

in this applet.
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Working with List Applets
Working with List Applets 0

A list applet, as you’ve seen, is a group of records presented as a list of rows. A list 
applet is useful for seeing multiple records at one time. For example, when you 
perform a query that yields 10 matching records, a list applet enables you to see all 
10 records at once.

Besides viewing information, you can use a list applet to perform queries and to 
update fields—just as with a form applet. 

Changing Column Order and Appearance 0

To make the records in a list applet easier for you to work with, you can change the 
order of the columns, resize the columns to see more or less of a particular field, 
and change the records’ sort order.

NOTE: If you want to rearrange several columns, or if the columns you want to 
rearrange are far apart, you may find it easier to use the Columns Displayed dialog 
box. To bring up this dialog box, right-click inside the list applet and choose 
Columns Displayed from the shortcut menu that appears.

Figure 20. Changing the Appearance of Lists

To move a column ahead of another, drag the
column header to the left until you see a red

line, then drop the column.

To resize a column,
drag the right edge of
the column header.
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Working with List Applets
Changing the Sort Order 0

You can sort the records in a list by any column. For example, you can sort a list of 
contacts so they appear alphabetically by name (the Name column) or 
chronologically by date (the Date column). 

When you click a column to select it, be sure to click outside the hyperlink. Clicking 
the hyperlink takes you to another view, as explained in the next section.

NOTE: If you want to specify more than one column on which to sort (for example, 
Name and Site), use the Sort Order dialog box, just as you would in Microsoft Excel. 
To bring up this dialog box, right-click inside the list applet and choose Sort Order 
from the shortcut menu that appears.

Figure 21. Changing the Sort Order

Then click one of the Sort
buttons to sort from A to Z or
from Z to A.

Click anywhere in the
column you want to sort
by. For example, to sort
by account name, click

the Account column.
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Working with List Applets
Drilling Down for More Details 0

In some list applets, the fields in one or more columns appear as hyperlinks 
(underlined and in color). You can click a hyperlink to go to another view that has 
more detailed information about the item. 

Figure 22. Drilling Down on a Hyperlink

Click the hyperlink to drill down to
more information about this contact.

The view that appears contains more
information about this contact—including
the activities associated with the contact.
22 Siebel Basics Version 6.0
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Working with Form Applets
Working with Form Applets 0

As you’ve seen, you can do many things using a list applet: perform queries, view 
information, and update information. But sometimes it’s easier to do these things 
when the data is arranged in a form-like layout. This is why the form-list view type 
is so common in Siebel applications. Having the two types of applet in one view 
enables you to go easily back and forth between the two representations of the data, 
depending on what’s more convenient for you at the moment.

Entering Data 0

Form applets are particularly handy for entering data (though you can also enter 
data in a list applet). Because the whole applet area is available for just a single 
record, a form applet can display more of a record’s fields without requiring you to 
scroll—and can often show more text in a long field than a list applet can.

NOTE: Like editable fields, read-only fields can appear in list applets, as well.

The following two sections describe the two special types of fields that can be edited 
only by clicking the button next to them.

Figure 23. Entering Data

To enter data, just click inside
a field and start typing.

A field that appears gray when you click it (and
does not have a button next to it) is read-only.

You cannot change data in this field.

To enter data in a field
with a button next to it,
click the button.
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Working with Form Applets
Using Picklists 0

Some fields have a small triangle button next to them. Clicking this button displays 
a list of possible values for this field.

Picklists make it faster for you to enter information and ensure that the values you 
enter are valid.

Picklists can appear in list applets, as well, but you won’t see a triangle until you 
click inside the field you want to change.

Figure 24. Using Picklists

Click the triangle to see
a picklist of values.

From the list that appears, click the
value you want to choose.
24 Siebel Basics Version 6.0



Siebel Basics

Working with Form Applets
Using Multi-Value Groups and Seeing More Information 0

Sometimes, a single field can contain multiple values at once. For example, an 
account often has more than one address. Similarly, the Account Team field 
contains the usernames of all the team members. A field that contains more than 
one value is called a multi-value group, or MVG.

A field in a form can display only one value at a time; therefore, to see the other 
values in a multi-value group, you must bring up the MVG applet, which you do by 
clicking the ellipsis button (...).

MVGs, like picklists, can appear in list applets as well as in form applets.

NOTE: An ellipsis button does not always mean that the information not displayed 
is part of an MVG. Sometimes, clicking the ellipsis button simply brings up a long 
text field.

Figure 25. Using the Ellipsis Button to Bring Up an MVG

2 In the MVG applet
that appears, you can

scroll or use buttons
just as you would in

any applet or Windows
dialog box.

1 Click the ellipsis button to
see all the members of this

account’s team.
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At the very bottom of the application window are two bars that display information, 
as shown in Figure 26.

Figure 26. Message Bar and Status Bar

The most important part of the status
bar is this counter, which shows how

many records are displayed and
which record you’re currently viewing.

Use this arrow to fast-forward
through the scrolling messages.

The message bar shows a scrolling
sequence of messages from your

company. To pause the scrolling, drag
your pointer over the bar.

The status bar often shows a brief
description of the current field.
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As you learned earlier, many aspects of your application can be customized. You 
can set many preferences yourself by using the Options dialog box, shown in 
Figure 27.

 

To bring up the Options dialog box, choose Options from the View menu.

Figure 27. Options Dialog Box

Other tabs enable you to
set options for the
behavior of other parts of
the application.

Click the Appearance
tab to set options that
control how your
application looks.

You can choose different
colors for such items as
titles, buttons, hyperlinks,
and row selections.
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